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Instructions for Authors

GENERAL INFORMATION

The manuscript should not exceed 5000 words
in length (excluding references) and should
include a maximum of five figures. Please use
color artwork only when necessary, because this
increases the cost of the print version.

Please submit your manuscript online at
http://submit-cshl.highwire.org/. We will dis-
tribute manuscripts to the appropriate Editor
and contact you to request any revisions they
require within 4–6 weeks. After you have made
appropriate changes, please upload the revised
manuscript on the site.

Note that the initial submission may be a
single PDF file, but you must supply the origi-
nal source files for text and figures when
uploading the revised version.

ORGANIZATION

Include: Title page that includes title, authors,
departments, institutions, city, state (country),
zip code, telephone and fax number(s) and e-
mail addresses, and suggested short title (50
characters and spaces) for running head. If
more than one author and institution are given,
please indicate each author’s affiliation. Indicate
which author will be the corresponding author,
that is, the author who will be responsible for
receiving and returning proofs.

Arrange manuscript pages in the following order:

• Title page

• Abstract (100–140 words)

• Introduction

• Main text, including subheadings

• Concluding remarks

• Acknowledgments

• References

• Figure Legends

• Tables 

REFERENCES

How to Style References

All references in the reference list should be
double-spaced and arranged alphabetically by
last name of the first author. If using more than
one reference by the same author in the same
year, please label “a” and “b” next to the date on
the list as well as in the text citation. Do not use
a numbered reference list or cite by number
in the text. Make sure that all references cited
are included in the reference list and that all
references listed are cited in the text. If you are
using EndNote, please select the Genes and
Development style.

Reference Citations in Text

Cite author and year in text. Use “et al.” for
more than two authors. If more than one paper
is cited, place in chronological order (Smith
1994; Brown 1995; Jones et al. 1996). For cita-
tions of unpublished work or personal commu-
nication, provide names and first initials—for
example, (P Jones, unpubl.) or (P Jones, pers.
comm.). These will not be listed in the reference
list, which is to contain only published work.

Reference List

1. See Sample Reference List below for style.

2. Include the following:
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a. Journal articles: Provide all authors’ names
(do not use “et al.” or three em dashes), year,
article title, journal title (italic), volume num-
ber (bold), and inclusive page numbers. For
online-only journals or published-ahead-of-
print papers, provide a DOI number.

b. Books: Provide all author/editors’ names (do
not use “et al.”), chapter title, book title (italic),
names of editors, volume or edition (if any),
inclusive page numbers, publisher, and city of
publication.

3. List multiple authors as follows: Brown D,
Smith JG, White AS, Jones LR.

4. Alphabetize according to author’s last name.

Sample Reference List

Ahnn J, Fire A. 1994. A screen for genetic loci required for
body-wall muscle development during embryogenesis in
Caenorhabditis elegans. Genetics 137: 483–498.

Ahringer J. 1991. “Post-transcriptional regulation of fem-3,
a sex-determining gene of C. elegans.” PhD thesis,
University of Wisconsin, Madison.

Barstead RJ, Waterston RH. 1991a. Vinculin is essential for
muscle function in the nematode. J Cell Biol 114: 715–724.

Barstead RJ, Waterston RH. 1991b. Cloning, sequencing,
and mapping of an a-actinin gene from the nematode
Caenorhabditis elegans. Cell Mobil Cytoskel 20: 69–78.

Chalfie M Jr, Thomson JN, Sulston JE. 1983. Induction of
neuronal branching in C. elegans. Science 221: 61–63.

Fischmann DA, Vaughn K, Weber F, Einheber S. 1991.
Myosin binding proteins: Intracellular members of the
immunoglobulin super family. In Frontiers of muscle
research: Muscle contraction and muscle dystrophy, 2nd
ed. (ed. E Ozawa et al.), pp. 211–222. Elsevier,
Amsterdam.

Gerhart J. 1980. Mechanisms regulating formation in the
amphibian egg and early embryo. In Biological regulation
and development (ed. RF Goldberger), Vol. 1, pp.
133–316. Plenum, New York. 

Johnson J. 2000. The mouse. In Proceedings of the Tenth
Annual Meeting of Mouse Genetics, p. 83. Jackson
Laboratory, Bar Harbor, ME. 

Komissarova N, Kashlev M. 2009. Arrest of transcription:
Escherichia coli RNA polymerase translocates backward,
leaving the 3¢ end of the RNA intact and extruded. Proc
Natl Acad Sci (in press).

Levesque M. 2007. A microRNA feedback circuit in mid-
brain dopamine neurons. PloS ONE 2: e1227. doi:
10.1371/journal.pone/0001227.

Proudfoot L, Kusel JR, Smith HV, Kennedy MW. 1993a.
External stimuli and intracellular signalling in the mod-
ification of the nematode surface during transmission to
the mammalian host environment. Parasitology 107:
556–559.

Proudfoot LJ, Kusel JR III, Smith HV, Hanett W, Worms MJ,
Kennedy MW, Johnson AB, Thomas E, Lin X, Corbett K,
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et al. 1993b. Rapid changes in the surface of parasitic
nematodes during transition from pre- to post-parasitic
forms. Parasitology 107: 107–117.

Sive HL, Grainger M, Harland RM. 2000. Early development
of Xenopus laevis: A laboratory manual. Cold Spring
Harbor Laboratory Press, Cold Spring Harbor, NY.

FIGURES

1. We can only accept your final electronic art
as an EPS or TIFF file (you may supply a
PDF at initial submission as noted above,
however). Virtually all common artwork
programs are capable of saving files in these
formats. These options can normally be
found under the ‘Save As…’ or ‘Export…’
commands in the ‘File’ menu. (See specific
instructions below on saving your files in the
most common programs.)

2. All images should be saved in CMYK (color),
grayscale (halftones), or bitmap (black and
white line art) mode. If your image has fluo-
rescent colors, you can submit the artwork in
RGB. Since many readers will view articles as
PDF files printed out in black-and-white,
avoid using color to distinguish elements in
figures where this can instead be achieved by
use of gray shades or dashed lines.

3. Image resolution is critical to the clarity and
sharpness of the final printed piece. Image
resolution should be set at 300 DPI for color
and grayscale artwork. All line art (bitmap
images) should be 1200 DPI. When supply-
ing images please make sure the files are at
the correct resolution. Any figures that do
not meet the above requirement may be
returned for a better quality image.

4. Use Helvetica postscript font in point sizes
no smaller than 6 pt type and no larger than
10 pt type. All main type in artwork should
be 7.5 pt. Please make sure all fonts are
embedded in the image. CSHL Press strives to
make all artwork look consistent online and in
printed form. To achieve this, it is important
to use the Helvetica postscript font as well as
follow the directions below for creating your
artwork (see Creating Your Artwork).

5. If your figure has multiple parts (more than
one image in the figure), please make sure
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the part labels (A, B, C, D) are 9 pt Helvetica
bold, cap.

6. Authors may mail a print of their artwork if
they are concerned that elements might not
convert accurately during production.

7. Please make sure that your files are properly
labeled by figure number and format (e.g.,
Fig_1.tif or Fig_2.eps) and that the printout
is properly labeled and corresponds to the
file name.

8. Upload only final art files that have been care-
fully proofread. Do not embed figure legends
in the art files. All figure legends should be
placed at the end of the manuscript. Do not
embed figures within the text files. For exam-
ple, figures should not be embedded in a
Word file. The figures should be separate files.

Saving Files in Illustrator and Photoshop

Adobe Illustrator

1. Under the File menu, choose save as, format
(Illustrator EPS).

2. Click save and a window comes up.

3. Save as “Illustrator EPS.”

4. Under options, click include document
fonts, click include document thumbnails.

5. Preview should be checked as 8-bit Macintosh.

6. Click okay.

7. In case we have trouble with your file, please
download all fonts on the disk that were
used in creating your artwork. The preview
box is very important. Make sure it is checked
off as 8-bit Macintosh.

If your artwork is in 4-color, please make sure
you create the artwork using CMYK (not RGB)
colors.

Adobe Photoshop

1. Under the File menu, choose save as, format
(TIFF).

2. Click save.

3. Under TIFF options check Macintosh; do
not check LZW compression.

4. Click okay.

If your artwork is in 4-color, please make sure
you create the artwork using CMYK colors (not
RGB or Pantone colors). Please make sure the
resolution is set at 300 dpi.

Creating Artwork

1. Please create your artwork at exact size. The
trim size of this publication is 7 x 10", double
column layout. Artwork should be no larger
than 2 ½" wide (6.35 cm) to fit in single col-
umn and can go up to 5 ½" wide (13.97 cm)
to go across both columns. Artwork should
be no longer than 7" (17.78 cm).

2. All type should be set in Helvetica post-
script font. Optimum point size for type
should be 7.5 pt. Type sizes can vary but
should range no smaller than 6 pt type and
no larger than 10 pt type. Labels should be
in sentence case.

3. Part labels (A, B, C, D) should be 9 pt.
Helvetica bold, cap.

4. All fonts should be embedded in the file.

5. Line widths (as well as dotted lines and lines
with arrows) should be .5 pt to .75 pt as the
basic line weight for drawing, with heavier
or lighter line weights for emphasis.

6. If you are bringing TIFF images into
Illustrator, make sure “include placed files” is
checked in the options box.

7. When creating tints (shades of black or
color), please make sure you do not go above
20% when type is placed over the tinted area
(unless the text is knocked out to white). All
color artwork should be created in CMYK
mode.

8. Color choices should be harmonious
throughout. There should be consistency of
color choice, tone, density, and hue for each
article. Avoid the use of “neon” colors. No
color panels should be used for back-
grounds. Shading and highlighting should
be subtle.



Overprinting Black and Colors

Overprint black ink to aid in registration.
Because black ink is opaque (and usually the
last to be printed), it does not look much dif-
ferent when printed over a color as opposed to
a white background. Overprinting black can
prevent gaps from appearing between black and
colored areas of your artwork.

• Overprint when the artwork does not share
common ink colors and you want to create a
trap or overlaid ink effects. When overprint-
ing process color mixes or custom colors
that do not share common ink colors, the
overprint color is added to the background
color. For example, if you print a fill of 100%
magenta over a fill of 100% cyan, the over-
lapping fills appear violet, not magenta.

• After you set overprinting options, you
should use the Overprint Preview mode
(View > Overprint Preview) to see an
approximation of how the overprinting col-
ors will print. You should also carefully
check overprinted colors on separated art-
work using integral proofs (where each sep-
aration is shown in register on a single piece
of paper) or overlay proofs (where the sepa-
rations are shown in register on separate
plastic sheets stacked on top of each other).

• Under the Help menu in Illustrator, direc-
tions for implementing overprinting are
clearly explained.

TABLES

Supply a brief table title and, where necessary,
an explanatory legend as a footnote. Each col-
umn should have an appropriate heading.
Please supply all tables in Word format (not as
figures/images).

LEGENDS

Legends for figures and tables should start with a
short title that describes what is shown. The
remainder of the legend should be as brief as pos-
sible and should not contain experimental detail.
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Parts of figures should be labeled with capital let-
ters, “A”, “B”, “C”, etc. and should be explained in
the legend, not on the figure itself. Symbols
should also be explained in the legend only. Please
indicate clearly if the figure or table is taken from
elsewhere (e.g., Reprinted [or Modified], with
permission, from Proudfoot et al. 1993a.) and
obtain permission to reprint (see below).

MOVIES

Please feel free to include movies to accompany
the online version. You should first contact the
Production Coordinator to establish whether
the file format and size are acceptable. Be sure
to include a descriptive legend.

PERMISSIONS

It is your responsibility to obtain permission
(from the copyright holder) to reproduce or
modify any figure or table that has been previ-
ously published and forward a copy of the per-
mission to the Project Manager. Note that we
need both print and non-print (online) media
rights. The figure or table legend should contain
the relevant permission statement information
(e.g., Reprinted [or Modified or Redrawn or
Adapted], with permission, from author and
year.) and a complete reference must appear in
the Reference List. Authors must also obtain
permission to reprint material from WWW sites
from the Webmaster of that site.

ETHICS

Conflicts of Interest Upon acceptance, each
author is required to declare any conflict of inter-
est or competing financial interest that may be
perceived as contributing to potential bias.
Examples would be funding for a research pro-
gram or employment by or stocks or shares in
one or more organizations that may be financial-
ly affected by the publication of this paper, as well
as patents or patent applications whose value
may be affected by the publication of this paper.

Protection of Human Subjects and Animals in
Research Where data from experiments involv-
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ing animals or human subjects are shown,
authors must demonstrate that these were in
accordance with the ethical standards of the rel-
evant institutional and national committees for
such matters.

Informed Consent Where identifying informa-
tion, such as patients’ names, initials, or hospital
numbers, is shown, authors must demonstrate
that the patient (or parent or guardian) has given
written informed consent for publication and
been shown the manuscript prior to publication.

Attribution and Plagiarism Authors must
endeavor to ensure that previously published
work is appropriately acknowledged and cited
correctly. Where statements made in previous-
ly published work are reproduced verbatim,
this should be indicated by the use of quota-
tion marks (“”), and an accompanying refer-
ence must be provided. Cold Spring Harbor
Laboratory Press reserves the right to employ
automated tools to identify any instances of
plagiarism and withdraw the contribution if
this is detected.
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